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Unit Overview
This unit is about:
Google Apps, which is a set of web applications provided by Google. These web applications include Google
Email, Google Calendar, Google Docs, Google Talk (Chat), Google Mobile and Google Sites.
All of these web applications offer an online alternative to traditional office suites. Thus you can look at
Google Apps as an online office suite. Students will become familiar will the office suite.
Students will also become familiar with online resources that can support them at College and the workplace.
Additionally students will be able to implement and master proficiency in Microsoft Word -Students will be
able to do complex editing, format text, format paragraphs and documents, work with graphics and work with
documents.
We will also take a more guided, hands-on and project-oriented approach will be utilized to instruct students
in the use of the computer as a business analysis and applications and communications tool. A strong
computer background, interdisciplinary connections and real-life business applications will be stressed.Unit of
study include the design of professional-looking word documents, statistical analysis, multimedia
presentations, desktop publishing, database applications with queries and reports and web development and
design. We will tie to togther the whole Microsoft suite.
 
Students will aslo be encouraged to take Microsoft Certification Exams to support be job / college ready.
 



 

 

 

Enduring Understanding
The effective use of technology is vital for success in the information age.
When using technology, how does your attention to ergonomics increase your productivity and employability?
Why learn technology?
How does the use of technology create opportunity?
Technology enhances your ability to gather, manipulate and communicate information.
How does your ability to select and use software enhance communication?
How does your ability to use a variety of hardware enhance communication?
How can knowledge of technology improve your decision-making and problem-solving skills?
The practice of employability skills leads to personal and workplace success.
What are the relationships between employability skills and success in life? What is a good worker?
How does ethical or non-ethical behavior with technology impact society?
Operations and applications within Microsoft Word can be used to create
professional looking documents.
Today’s computer applications extend beyond the traditional office environment and
office software applications. Web development and web communication have become
an essential part of our everyday lives. It is important for the student to understand how
to create business documents and portfolios for the global audience.
 

 

 

 

Essential Questions
Does the student exhibit proper classroom procedures that contribute positively to the learning environment?
How do English skills apply to computer applications?
What are some of the most useful features of Word for my life now and in the future?
How does software enhance the productivity of the workforce?
How do you professionally create and develop business documents? Why is this process important?
How does the information on the internet enhance one’s research abilities compared to research methods of
the past?
How is document content created and refined?
When and why should tables be used to effectively organize and communicate information?
How do you create a document with a table, chart and watermark?



Which Word features facilitate collaborative editing of documents?
How would you demonstrate advanced skills to utilize the mail merge feature of Microsoft Word 2013?
How can we use visual and written elements effectively and efficiently to reach a
target audience?
How can numerical data be analyzed, evaluated and presented to address
issues and problems of scientific and public interest on a large scale?
Which graphical representations of numerical data can be designed to
communicate information on a broad scale?
 

 

 

 

Exit Skills
These are the skills that students will have obtained by the end of this unit:
 
Apply Formats to a Word Document. Performance will be satisfactory when:
 
o learner changes document settings including margins, page orientation, page alignment, etc.
o learner applies paragraph formatting including alignment, indentation, spacing before and after, line 
spacing, etc.
o learner applies text formatting including bold, underline, italics, size, typeface, and color.
o learner sets custom tabs.
o learner uses Format Painter.
 
Create Multiple-Paged Documents. Performance will be satisfactory when:
 
o learner inserts and formats page numbers.
o learner creates headers and footers.
o learner creates footnotes and/or endnotes.
o learner inserts section breaks.
 
Use Special Features in Word. Performance will be satisfactory when:
 
o learner creates bulleted and numbered lists.
o learner inserts and modifies clip art.
o learner creates tables.
 
Acquired Skills
1. Identify the purposes of word processing software
2. Use word processing software menu commands, functions and keyboard shortcuts
3. Create a file management structure
4. Proofread documents for content, grammatical and formatting errors
5. Open, create, change and save documents



6. Format documents: alignment, fonts (faces, size, color), line spacing, inserting tabs, ordered and unordered 
lists, headers and footers
7. Insert tables, hyperlinks, objects and graphics
8. Use advanced Word features such as insert comments and table of contents
9. Choose and use templates
10. Research and download internet information
 
Google Apps is a set of web applications provided by Google.
These web applications include Google Email, Google Calendar, Google Docs, Google Talk (Chat), 
Google Mobile and Google Sites.
All of these web applications offer an online alternative to traditional office suites. Thus you can look 
at Google Apps as an online office suite.
 
Students will become knowledgable and proficient in its use as well as:
 
Use the Research task pane to look up information.
Demonstrate advanced skills to utilize the mail merge feature of Microsoft Word 2007.
Explain the mail merge process.
Use the mail merge task pane and the Mailings tab on the Ribbon.
Use a letter template as the main document for a mail merge.
Create and edit a data source.
Insert merge fields in a main document.
Use an IF field in a main document.
Merge and print form letters.
Sort data records.
Add and print mailing labels and envelopes.
Merge all data records to a directory.
Change page orientation.
Modify table properties.
Create and format WordArt, SmartArt
Insert a symbol in a document.
Insert and format a floating graphic
Using the Internet Search engines
Demonstrate the ability to use internet browsers—explorer, navigator, and firefox.
Apply internet navigating skills in a variety of browsers—back, forward, home, refresh, stop, 
favorites, history, and other skills.
Define basic internet terminology.
Demonstrate the ability to use a variety of search engines—google, msn, yahoo, lycos, megacrawler, dogpile, 
etc.
Demonstrate ability use various skills to narrow down searches and find specific information—use Boolean 
operators, advanced search, various search words, etc.
Identify reliable sources found using internet searches and differentiate between reliable and nonreliable 
sources.
Apply researching skills to find answers to questions in an internet scavenger hunt.
 

 

 



New Jersey Student Learning Standards (NJSLS)
 

 

 

 

 

CS.9-12.8.1.12.CS.1 Describe ways in which integrated systems hide underlying implementation details to 
simplify user experiences. 

CS.9-12.8.1.12.CS.2 Model interactions between application software, system software, and hardware. 

CS.9-12.8.1.12.CS.3 Compare the functions of application software, system software, and hardware. 

CS.9-12.8.1.12.CS.4 Develop guidelines that convey systematic troubleshooting strategies that others can use 
to identify and fix errors. 

CS.9-12.CS Computing Systems 

CS.9-12.NI Networks and the Internet 

TECH.9.4.12.CI Creativity and Innovation 

TECH.9.4.12.CI.1 Demonstrate the ability to reflect, analyze, and use creative skills and ideas (e.g., 
1.1.12prof.CR3a). 

TECH.9.4.12.CI.2 Identify career pathways that highlight personal talents, skills, and abilities (e.g., 
1.4.12prof.CR2b, 2.2.12.LF.8). 

TECH.9.4.12.CI.3 Investigate new challenges and opportunities for personal growth, advancement, and 
transition (e.g., 2.1.12.PGD.1). 

TECH.9.4.12.CT Critical Thinking and Problem-solving 

TECH.9.4.12.CT.1 Identify problem-solving strategies used in the development of an innovative product or 
practice (e.g., 1.1.12acc.C1b, 2.2.12.PF.3). 

TECH.9.4.12.CT.2 Explain the potential benefits of collaborating to enhance critical thinking and problem 
solving (e.g., 1.3E.12profCR3.a). 

TECH.9.4.12.CT.3 Enlist input from a variety of stakeholders (e.g., community members, experts in the field) 
to design a service learning activity that addresses a local or global issue (e.g., 
environmental justice). 

Interdisciplinary Connections
 

 

 

LA.RL.11-12 Reading Literature 



LA.RL.11-12.1 Cite strong and thorough textual evidence and make relevant connections to support 
analysis of what the text says explicitly as well as inferences drawn from the text, including 
determining where the text leaves matters uncertain. 

LA.RL.11-12.2 Determine two or more themes or central ideas of a text and analyze their development 
over the course of the text, including how they interact and build on one another to 
produce a complex account; provide an objective summary of the text. 

LA.RL.11-12.3 Analyze the impact of the author’s choices regarding how to develop and relate elements 
of a story or drama (e.g., where a story is set, how the action is ordered, how the 
characters are introduced and developed). 

LA.RST.9-10.3 Follow precisely a complex multistep procedure when carrying out experiments, taking 
measurements, or performing technical tasks, attending to special cases or exceptions 
defined in the text. 

LA.RST.9-10.4 Determine the meaning of symbols, key terms, and other domain-specific words and 
phrases as they are used in a specific scientific or technical context relevant to grades 9-10 
texts and topics. 

LA.WHST.9-10.1 Write arguments to support claims in an analysis of substantive topics or texts, using valid 
reasoning and relevant sufficient textual and non-textual evidence. 

LA.WHST.9-10.2 Write informative/explanatory texts, including the narration of historical events, scientific 
procedures/experiments, or technical processes. 

LA.L.11-12.4 Determine or clarify the meaning of unknown and multiple-meaning words and phrases 
based on grades 11–12 reading and content, choosing flexibly from a range of strategies. 

LA.L.11-12.4.A Use context (e.g., the overall meaning of a sentence, paragraph, or text; a word’s position 
or function in a sentence) as a clue to the meaning of a word or phrase. 

LA.L.11-12.4.B Identify and correctly use patterns of word changes that indicate different meanings or 
parts of speech (e.g., conceive, conception, conceivable). 

LA.L.11-12.4.C Consult general and specialized reference materials (e.g., dictionaries, glossaries, 
thesauruses), both print and digital, to find the pronunciation of a word or determine or 
clarify its precise meaning, its part of speech, its etymology, or its standard usage. 

LA.L.11-12.4.D Verify the preliminary determination of the meaning of a word or phrase (e.g., by checking 
the inferred meaning in context or in a dictionary). 

Learning Objectives
The student will:
Create column, bar, line and pie charts - analyze statistical data, identify the data range, identify the chart type, 
create and modify the chart, add header and footer
Modify the visual representation of a chart
Apply and insert images into the charts
Construct and Design, link and embed Excel charts into Word documents
Explore various methods that Information Technology can be used to support existing businesses 
and strategies.
Investigate emerging technology in shaping new processes, strategies and business models.
Achieve hands-on experience with productivity/application software to enhance business activities.
Accomplish projects utilizing business theories, Internet resources and computer technology demonstrate 
appropriate printing features
Understand how to MS PowerPoint to create a presentation
Understand how to use and manipulate graphics, custom animation and video
 
Acquired Skills:
At the completion of this module, the student will be able to design, build and deliver a



presentation using MS PowerPoint:
1. create and add slides
2. layouts and formats
3. insert and manipulate graphics and charts and diagrams
4. slide design
5. slide transitions
6. custom animation
7. edit the slide master
8. improving presentation skills
Action Verbs: Below are examples of action verbs associated with each level of the Revised Bloom's Taxonomy.

Remember Understand Apply Analyze Evaluate Create
Choose
Describe
Define
Label
List
Locate
Match
Memorize
Name
Omit
Recite
Select
State
Count 
Draw
Outline
Point
Quote
Recall
Recognize
Repeat
Reproduce

Classify
Defend
Demonstrate
Distinguish
Explain
Express
Extend
Give Examples
Illustrate
Indicate
Interrelate
Interpret
Infer
Match
Paraphrase
Represent
Restate
Rewrite
Select
Show
Summarize
Tell
Translate
Associate
Compute
Convert
Discuss
Estimate
Extrapolate
Generalize
Predict

Choose
Dramatize
Explain
Generalize
Judge
Organize
Paint
Prepare
Produce
Select
Show
Sketch
Solve
Use
Add
Calculate
Change
Classify
Complete
Compute
Discover
Divide
Examine
Graph
Interpolate
Manipulate
Modify
Operate
Subtract

Categorize
Classify
Compare
Differentiate
Distinguish
Identify
Infer
Point out
Select
Subdivide
Survey
Arrange
Breakdown
Combine
Detect
Diagram
Discriminate
Illustrate
Outline
Point out
Separate

Appraise
Judge
Criticize
Defend
Compare
Assess
Conclude
Contrast
Critique
Determine
Grade
Justify
Measure
Rank
Rate
Support 
Test

Combine
Compose
Construct
Design
Develop
Formulate
Hypothesize
Invent
Make
Originate
Organize
Plan
Produce
Role Play
Drive
Devise
Generate
Integrate
Prescribe
Propose
Reconstruct
Revise
Rewrite
Transform



 

 

Suggested Activities & Best Practices
1. Apply Formats to a Word Document. Performance will be satisfactory when:

 
o learner changes document settings including margins, page orientation, page alignment, etc.
o learner applies paragraph formatting including alignment, indentation, spacing before and after, 
line spacing, etc.
o learner applies text formatting including bold, underline, italics, size, typeface, and color.
o learner sets custom tabs.
o learner uses Format Painter.

2. Students will identify famous African Americans whom contributed to the computer field.
3. Students will incorporate global technical energy efficient products in the computer field being used in 

the classroom.

 



 

 

 

Assessment Evidence - Checking for Understanding (CFU)
Unit test-summative assessment

Think, pair, share-formative assessment

Written reports-alternate assessment

Create a Multimedia poster-benchmark assessment

•    Admit Tickets     . 

•    Anticipation Guide     . 

•    Common Benchmarks     . 

•    Compare & Contrast     . 

•    Create a Multimedia Poster     . 

•    DBQ's     . 

•    Define     . 

•    Describe     . 

•    Evaluate     . 

•    Evaluation rubrics     . 

•    Exit Tickets     . 

•    Explaining     . 

•    Fist- to-Five or Thumb-Ometer     . 

•    Illustration     . 

•    Journals     . 

•    KWL Chart     . 

•    Learning Center Activities     . 

•    Multimedia Reports     . 

•    Newspaper Headline     . 

•    Outline     . 

•    Question Stems     . 

•    Quickwrite     . 

•    Quizzes     . 

•    Red Light, Green Light     . 



•    Self- assessments     . 

•    Socratic Seminar     . 

•    Study Guide     . 

•    Surveys     . 

•    Teacher Observation Checklist     . 

•    Think, Pair, Share     . 

•    Think, Write, Pair, Share     . 

•    Top 10 List     . 

•    Unit review/Test prep     . 

•    Unit tests     . 

•    Web-Based Assessments     . 

•    Written Reports     . 

Primary Resources & Materials
Multimedia, Microsoft Testing, Internet Connection, Student Emails /USB, Textbooks, Online resources such
as You Tube, SmartBoard.
 

Ancillary Resources
Online Resources such as Computer Training Tutorials like GCFlearning.com, You Tube Tutorials, Step by
 
Step Online computer training
 

Technology Infusion
Pod Casts, Khan Academy,Twitter, Microsoft Office Suite, Internet connection, Desktop Computers, 
Smart Boards/TV
 

What Technology Infusion and/or strategies are integrated into this unit to enhance learning? Please list all hardware, software and 
strategies. Please find a technology pedagogy wheel for assistance while completing this section.

 



 

 

 

 



Alignment to 21st Century Skills & Technology
 

 

 

WRK.9.2.12.CAP Career Awareness and Planning 

WRK.9.2.12.CAP.1 Analyze unemployment rates for workers with different levels of education and how the 
economic, social, and political conditions of a time period are affected by a recession. 

WRK.9.2.12.CAP.2 Develop college and career readiness skills by participating in opportunities such as 
structured learning experiences, apprenticeships, and dual enrollment programs. 

WRK.9.2.12.CAP.3 Investigate how continuing education contributes to one's career and personal growth. 

WRK.9.2.12.CAP.4 Evaluate different careers and develop various plans (e.g., costs of public, private, training 
schools) and timetables for achieving them, including educational/training requirements, 
costs, loans, and debt repayment. 

WRK.9.2.12.CAP.5 Assess and modify a personal plan to support current interests and post-secondary plans. 

WRK.9.2.12.CAP.6 Identify transferable skills in career choices and design alternative career plans based on 
those skills. 

WRK.9.2.12.CAP.7 Use online resources to examine licensing, certification, and credentialing requirements at 
the local, state, and national levels to maintain compliance with industry requirements in 
areas of career interest. 

WRK.9.2.12.CAP.8 Determine job entrance criteria (e.g., education credentials, math/writing/reading 
comprehension tests, drug tests) used by employers in various industry sectors. 

TECH.9.4.12.CI Creativity and Innovation 

TECH.9.4.12.CI.1 Demonstrate the ability to reflect, analyze, and use creative skills and ideas (e.g., 
1.1.12prof.CR3a). 

TECH.9.4.12.CI.2 Identify career pathways that highlight personal talents, skills, and abilities (e.g., 
1.4.12prof.CR2b, 2.2.12.LF.8). 

TECH.9.4.12.CI.3 Investigate new challenges and opportunities for personal growth, advancement, and 
transition (e.g., 2.1.12.PGD.1). 

TECH.9.4.12.CT Critical Thinking and Problem-solving 

TECH.9.4.12.CT.1 Identify problem-solving strategies used in the development of an innovative product or 
practice (e.g., 1.1.12acc.C1b, 2.2.12.PF.3). 

TECH.9.4.12.CT.2 Explain the potential benefits of collaborating to enhance critical thinking and problem 
solving (e.g., 1.3E.12profCR3.a). 

TECH.9.4.12.CT.3 Enlist input from a variety of stakeholders (e.g., community members, experts in the field) 
to design a service learning activity that addresses a local or global issue (e.g., 
environmental justice). 

TECH.9.4.12.CT.4 Participate in online strategy and planning sessions for course-based, school-based, or 
other project and determine the strategies that contribute to effective outcomes. 

21st Century Skills/Interdisciplinary Themes



Upon completion of this section, please remove all remaining descriptions, notes, outlines, examples and/or illustrations that are not 
needed or used.

 

Please list only the 21st Century/Interdisciplinary Themes that will be incorporated into this unit.

•    Communication and Collaboration     . 

•    Creativity and Innovation     . 

•    Critical thinking and Problem Solving     . 

•    ICT (Information, Communications and Technology) Literacy     . 

•    Information Literacy     . 

•    Life and Career Skills     . 

•    Media Literacy     . 

21st Century Skills
Upon completion of this section, please remove all remaining descriptions, notes, outlines, examples and/or illustrations that are not 
needed or used.

 

Please list only the 21st Century Skills that will be incorporated into this unit.

 

•    Civic Literacy     . 

•    Environmental Literacy     . 

•    Financial, Economic, Business and Entrepreneurial Literacy     . 

•    Global Awareness     . 

•    Health Literacy     . 

Differentiation
Upon completion of this section, please remove all remaining descriptions, notes, outlines, examples and/or illustrations that are not 
needed or used.

 

Please remember: Effective educational Differentiation in a lesson lies within content, process, and/or product. 

 

Please identify the ones that will be employed in this unit. 

 



 

Differentiations:

• Small group instruction

• Small group assignments

• Extra time to complete assignments

• Pairing oral instruction with visuals

• Repeat directions

• Use manipulatives

• Center-based instruction

• Token economy

• Study guides

• Teacher reads assessments allowed

• Scheduled breaks

• Rephrase written directions

• Multisensory approaches

• Additional time

• Preview vocabulary

• Preview content & concepts

• Story guides

• Behavior management plan

• Highlight text

• Student(s) work with assigned partner

• Visual presentation

• Assistive technology

• Auditory presentations

• Large print edition

• Dictation to scribe

• Small group setting

Hi-Prep Differentiations:

• Alternative formative and summative assessments

• Choice boards

• Games and tournaments

• Group investigations

• Guided Reading

• Independent research and projects

• Interest groups

• Learning contracts

• Leveled rubrics

• Literature circles

• Multiple intelligence options

• Multiple texts

• Personal agendas

• Project-based learning

• Problem-based learning

• Stations/centers

• Think-Tac-Toes

• Tiered activities/assignments

• Tiered products



• Varying organizers for instructions

Lo-Prep Differentiations

• Choice of books or activities

• Cubing activities

• Exploration by interest

• Flexible grouping

• Goal setting with students

• Jigsaw

• Mini workshops to re-teach or extend skills

• Open-ended activities

• Think-Pair-Share

• Reading buddies

• Varied journal prompts

• Varied supplemental materials

 

 

Special Education Learning (IEP's & 504's)
Please identify the Special Education Learning adaptations that will be employed in the unit, using the ones identified below.

 

•    printed copy of board work/notes provided     . 

•    additional time for skill mastery     . 

•    assistive technology     . 

•    behavior management plan     . 

•    Center-Based Instruction     . 

•    check work frequently for understanding     . 

•    computer or electronic device utilizes     . 

•    extended time on tests/ quizzes     . 

•    have student repeat directions to check for understanding     . 

•    highlighted text visual presentation     . 

•    modified assignment format     . 

•    modified test content     . 

•    modified test format     . 

•    modified test length     . 

•    multi-sensory presentation     . 

•    multiple test sessions     . 



•    preferential seating     . 

•    preview of content, concepts, and vocabulary     . 

•    Provide modifications as dictated in the student's IEP/504 plan     . 

•    reduced/shortened reading assignments     . 

•    Reduced/shortened written assignments     . 

•    secure attention before giving instruction/directions     . 

•    shortened assignments     . 

•    student working with an assigned partner     . 

•    teacher initiated weekly assignment sheet     . 

•    Use open book, study guides, test prototypes     . 

English Language Learning (ELL)
Please identify the English Language Learning adaptations that will be employed in the unit, using the ones identified below.

 

 

•    teaching key aspects of a topic.  Eliminate nonessential information     . 

•    using videos, illustrations, pictures, and drawings to explain or clarif     . 

•    allowing products (projects, timelines, demonstrations, models, drawings, dioramas, poster boards, 
charts, graphs, slide shows, videos, etc.) to demonstrate student’s learning;

    . 

•    allowing students to correct errors (looking for understanding)     . 

•    allowing the use of note cards or open-book during testing     . 

•    decreasing the amount of workpresented or required     . 

•    having peers take notes or providing a copy of the teacher’s notes     . 

•    modifying tests to reflect selected objectives     . 

•    providing study guides     . 

•    reducing or omitting lengthy outside reading assignments     . 

•    reducing the number of answer choices on a multiple choice test     . 

•    tutoring by peers     . 

•    using computer word processing spell check and grammar check features     . 

•    using true/false, matching, or fill in the blank tests in lieu of essay tests     . 

At Risk
Please identify Intervention Strategies that will be employed in the unit, using the ones identified below.

•    allowing students to correct errors (looking for understanding)     . 

•    teaching key aspects of a topic.  Eliminate nonessential information     . 

•    allowing products (projects, timelines, demonstrations, models, drawings, dioramas, poster boards,     . 



charts, graphs, slide shows, videos, etc.) to demonstrate student’s learning

•    allowing students to select from given choices     . 

•    allowing the use of note cards or open-book during testing     . 

•    collaborating (general education teacher and specialist) to modify vocabulary, omit or modify items to 
reflect objectives for the student, eliminate sections of the test, and determine how the grade will be 
determined prior to giving the test.

    . 

•    decreasing the amount of workpresented or required     . 

•    having peers take notes or providing a copy of the teacher’s notes     . 

•    marking students’ correct and acceptable work, not the mistakes     . 

•    modifying tests to reflect selected objectives     . 

•    providing study guides     . 

•    reducing or omitting lengthy outside reading assignments     . 

•    reducing the number of answer choices on a multiple choice test     . 

•    tutoring by peers     . 

•    using authentic assessments with real-life problem-solving     . 

•    using true/false, matching, or fill in the blank tests in lieu of essay tests     . 

•    using videos, illustrations, pictures, and drawings to explain or clarify     . 

Talented and Gifted Learning (T&G)
 

Please identify the Talented and Gifted adaptations that will be employed in the unit, using the ones 
identified below.

•    Above grade level placement option for qualified students     . 

•    Advanced problem-solving     . 

•    Allow students to work at a faster pace     . 

•    Cluster grouping     . 

•    Complete activities aligned with above grade level text using Benchmark results     . 

•    Create a blog or social media page about their unit     . 

•    Create a plan to solve an issue presented in the class or in a text     . 

•    Debate issues with research to support arguments     . 

•    Flexible skill grouping within a class or across grade level for rigor     . 

•    Higher order, critical & creative thinking skills, and discovery     . 

•    Multi-disciplinary unit and/or project     . 

•    Teacher-selected instructional strategies that are focused to provide challenge, engagement, and 
growth opportunities

    . 

•    Utilize exploratory connections to higher-grade concepts     . 

•    Utilize project-based learning for greater depth of knowledge     . 



Sample Lesson
Destination USA/ Creating a Travel Brochure

 

Lesson Plans

 

Directions: See your teacher about which state you both decide upon. The purpose of this activity is to

generate a travel brochure for each state, so each student must sign up on the class roster to ensure equal

state distribution. When gathering information about your assigned state, make sure that the material

you include is interesting and the pictures you use will capture the attention of others. When planning

your brochure, ask yourself what things would draw you to that state. The reason states make travel

brochures are to encourage people to come visit them.

Click on the "State Fact Worksheet" for your brochure outline. The things you should include in your

brochure are listed on this sheet. Use this as a rough draft in order to better organize your information.

Make sure you have the fact sheet checked by your teacher before inserting the information into your

Microsoft Publisher Brochure Publication.

To type directly on the state fact worksheet, click on link to open the worksheet, then save it to your

student folder. You will then open it in word in order to fill in your answers. When you have completed

your assignment, click on file, save as, choose your student folder from the list window, name your file

Travel Brochure, and click save.

 

State Fact Worksheet

The following web sites are to be used to gather your information:

State Information

Climate Information

State Abbreviations

Stately Knowledge

About 50 States

50 Nifty States



U.S. States

The US 50

Tourist Information

On Route/The Travel Source

Travel Library

 

Official State "Symbols" and Mascots

 

State Flowers

 

Discovery/Plan a Trip by Destination

Offbeat Tourist Attractions

Savvy Traveler

 

Assignment 2:

Open Microsoft Publisher. Choose the informational brochure you wish to use to construct your state's

travel information. Make sure you use enough graphics to make it appealing to someone who is looking

for a place to visit. Also, including a road map of the state for interested tourist is helpful for those not

familiar with the area. Include all the information stored in your State Fact Worksheet (you do not need to

include all state graphics, just the ones you think would enhance the look of your brochure. Name your

travel brochure state (where state is the name of the state you researched).
 

Assignment 3:The next assignment is to learn how use critical thinking skills in writing questions that you

will construct in the form of a scavenger hunt in your next assignment. You will read Jack and the

Beanstalk (I know its been a long time since I had read the story!!!), then determine what type of

questions were asked based on Blooms Taxonomy. Examples will be provided so you will know how to

construct your own. Click on Jack and the Beanstalk below and follow the directions provided in the

assignment.



 

Jack and the Beanstalk/An Adventure in Using Critical Thinking Skills

 

Assignment 4:

Now that you have become familiar with your state, open Microsoft Word to create a 20 question

interactive scavenger hunt in the form of a web page. The directions to how questions will be asked was

covered in the Jack and the Beanstalk assignment. You will use Bloom's taxonomy to create questions that

reflect higher level thinking skills. Remember to make your scavenger appealing to your audience. The

most creative and well thought out scavenger hunts will be posted on Nicholson's Lesson Plan Blues State

Scavenger Hunts with you as the author. In this assignment you may use animated graphics to make your

final product eye appealing for your audience. Save the scavenger hunt with your name_statename.

When you have finished the scavenger hunt, have another classmate answer your questions, saving the

file with their name_statename.The instructions for creating an interactive scavenger hunt is listed below:

Creatingan Interactive Scavenger Hunt Web Page

•  Open Microsoft Word
•  Save it As a Web Page
•  Chose File>Save As, then in the File Save As Type box, chose Web Page and save your page as listed 

above
• On the top line using WordArt, place the name of your state center
• On the second line, type By: followed by your name
• Under your name, insert a horizontal line
• o Position the insertion point on the blank line below your name
• o Click Format, and then Borders and Shading
• o At the Borders and Shading dialog box, click the Horizontal Line button that displays at the bottom 

of the dialog box
• o At the Horizontal Line dialog box, click the horizontal line of your choice
• Apply a background theme to you page:
• o Click Format>Theme to display the theme dialog box
• o Click a theme in the Choose a Theme list box to preview displays on the right side
• o Click OK to close the dialog box and apply the theme to the document
• If you can't find a theme you like, you can also apply formatting to the background:
• o Click Format and then Background. Apply a solid color, or add fill effects
• Creating Hyperlinks:
• o First type the questions you wish to have answered (Ex: What is the state flower?)
• o Choose the key word in the sentence you are looking for. In the above example, hold the left mouse 

down while selecting the word flower.
• o Click Insert>Hyperlink



• o At the Insert Hyperlink dialog box, key the Web page address of where you would find the answer in 
the Type the file or Web page name text box.

• o Click OK. (This changes the color of the text and also adds underling to the text.)
• o Continue adding links to every question. Have students look through a site to get their answers will 

make it more challenging
• Add animated graphics to you Web page that are appropriate for the your state (Insert>Picture>From 

File). The following web sites have some state animation graphics you can use:

 

Go Graph

Animation Library

Flaming Text Photos

2 Cool Graphics

Clip Art Warehouse

Beard Brothers Animating

Millanimations

 

Insert the state song:

 Locate the state song and save it to your folder (right click>save target as>name it statesong.

 Display the Web Tools Toolbar by clicking View>Toolbars>Web Tools

 Position the insertion point center on the line below the horizontal line

 Click the sound button on the Web Toolbar (has a speaker on it)

 At the Background Sound dialog box, click the Browse button

 At the File Open dialog box (with your folder displayed), double click the state song.

 At the Background Sound dialog box,click the down-pointing triangle at the right side of the Loop text box, 
and then click Infinite at the drop-down list.

 Click OK to close the Background Sound dialog box

Assignment 5:

You will now create a Power Point presentation about your state. Click on the link below for step-by-step

directions on how and what to include in in your presentation. Extra Credit will be given for including a

Flash movie in your presentation!!!!

 



 

CS.9-12.8.1.12.CS.1 Describe ways in which integrated systems hide underlying implementation details to 
simplify user experiences. 

CS.9-12.8.1.12.CS.2 Model interactions between application software, system software, and hardware. 

CS.9-12.8.1.12.CS.3 Compare the functions of application software, system software, and hardware. 

CS.9-12.8.1.12.CS.4 Develop guidelines that convey systematic troubleshooting strategies that others can use 
to identify and fix errors. 

CS.9-12.CS Computing Systems 

CS.9-12.NI Networks and the Internet 

TECH.9.4.12.CI Creativity and Innovation 

TECH.9.4.12.CI.1 Demonstrate the ability to reflect, analyze, and use creative skills and ideas (e.g., 
1.1.12prof.CR3a). 

TECH.9.4.12.CI.2 Identify career pathways that highlight personal talents, skills, and abilities (e.g., 
1.4.12prof.CR2b, 2.2.12.LF.8). 

TECH.9.4.12.CI.3 Investigate new challenges and opportunities for personal growth, advancement, and 
transition (e.g., 2.1.12.PGD.1). 

TECH.9.4.12.CT Critical Thinking and Problem-solving 

TECH.9.4.12.CT.1 Identify problem-solving strategies used in the development of an innovative product or 
practice (e.g., 1.1.12acc.C1b, 2.2.12.PF.3). 

TECH.9.4.12.CT.2 Explain the potential benefits of collaborating to enhance critical thinking and problem 
solving (e.g., 1.3E.12profCR3.a). 

TECH.9.4.12.CT.3 Enlist input from a variety of stakeholders (e.g., community members, experts in the field) 
to design a service learning activity that addresses a local or global issue (e.g., 
environmental justice). 


